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Copyright and Trademark Notices
Copyright   1992–2001 The Amanda Company. All Rights Reserved. This 
guide and the software described herein are copyrighted with all rights 
reserved. No part of this publication may be reproduced, transmitted, stored 
in a retrieval system, or translated into any language in any form by any 
means without the prior written permission of The Amanda Company.

Amanda and Amanda@ are registered trademarks and sales trademarks of 
The Amanda Company. Other brand names and product names mentioned in 
this manual are trademarks or registered trademarks of their respective 
owners.

Limited Warranty on Software
The Amanda Company warrants the media on which the software is recorded 
to be free from defects in materials and faulty workmanship for a period of 
90 days from the date the software is delivered. If a defect in the media 
should occur during this period, you may return the media to The Amanda 
Company and The Amanda Company will replace the media without charge.

THE AMANDA COMPANY MAKES NO WARRANTIES (OTHER 
THAN THOSE SET FORTH ABOVE) TO ANY PERSON OR ENTITY 
WITH RESPECT TO THE PRODUCT OR ANY DERIVATIVES 
THEREOF OR ANY SERVICES OR LICENSES AND DISCLAIMS ALL 
IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION 
WARRANTIES OF MERCHANTABILITY, PERFORMANCE, 
NONINFRINGEMENT, AND FITNESS FOR A PARTICULAR 
PURPOSE. THE AMANDA COMPANY WILL NOT BE LIABLE FOR 
ANY BUG, ERROR, OMISSION, DEFECT, DEFICIENCY, OR 
NONCONFORMITY IN ANY SOFTWARE. THE SOFTWARE IS 
LICENSED “AS IS,” AND THE PURCHASER ASSUMES THE ENTIRE 
RISK AS TO ITS QUALITY AND PERFORMANCE.

IN NO EVENT AND NOTWITHSTANDING ANY DOCUMENT, 
REPRESENTATION, OR OTHERWISE, SHALL THE AMANDA 
COMPANY BE LIABLE TO YOU FOR DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, CONTINGENT, OR CONSEQUENTIAL DAMAGES, 
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INCLUDING DAMAGES FROM LOSS OR CORRUPTION OF DATA, 
INTERRUPTED USE, LOST PROFITS, COST OF PROCURING 
SUBSTITUTE GOODS, TECHNOLOGY OR SERVICES, EVEN IF THE 
AMANDA COMPANY OR AN AUTHORIZED AMANDA COMPANY 
DEALER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. YOU AGREE THAT THE AMANDA COMPANY’S 
LIABILITY ARISING OUT OF CONTRACT, NEGLIGENCE, STRICT 
LIABILITY, WARRANTY, OR OTHER LEGAL OR EQUITABLE 
THEORY SHALL NOT EXCEED ANY AMOUNTS PAID BY YOU FOR 
THIS PRODUCT. Any written or oral information or advice given by 
Amanda Company dealers, distributors, agents, or employees will in no way 
increase the scope of this warranty, nor may you rely on such oral or written 
communication. Some states do not allow the exclusion or limitation of 
implied warranties or liability for incidental or consequential damages, so 
the above limitation or exclusion may not apply to you. This warranty gives 
you specific legal rights, and you may also have other rights which vary 
from state to state. This Agreement shall be governed by the laws of the 
State of California without regard to the conflicts of laws or provisions 
thereof.

Fraudulent Usage Advisory
Although the Amanda software is designed to resist fraudulent usage, 
including unauthorized access to a long distance network, no product, 
including the Amanda software, is able to prevent such unauthorized usage. 
The Amanda software is likewise unable to prevent such uses as may 
constitute an invasion of privacy or other tort. THE AMANDA COMPANY 
MAKES NO EXPRESS OR IMPLIED WARRANTY AGAINST 
UNLAWFUL OR UNAUTHORIZED USE OF YOUR AMANDA 
SYSTEM OR ITS CAPABILITIES AND HEREBY DISCLAIMS ALL 
LIABILITY ARISING FROM SUCH USE. YOU AGREE TO 
INDEMNIFY, DEFEND, AND HOLD THE AMANDA COMPANY 
HARMLESS FOR ANY UNAUTHORIZED OR FRAUDULENT USE OF 
YOUR LICENSED AMANDA SOFTWARE.

THE AMANDA COMPANY
13765 ALTON PARKWAY, UNIT F
IRVINE, CA  92618
TELEPHONE (949) 859–6279  FAX (949) 859–4380
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Conventions
This manual uses the following terminology and conventions:

Amanda The name by which this manual refers to the Aman-
da@Work.Group system to make reading about the 
system easier. Because of the name Amanda, the 
system is also referred to as “she.”

caller Someone who calls into Amanda. A caller often ob-
tains information, leaves a message for someone, 
and/or provides information. Because Amanda is 
referred to as “she,” callers and users are referred to 
as “he.”

user Someone with an extension that Amanda transfers 
calls to and/or stores messages for. A user can ac-
cess Amanda to play, delete, and send messages as 
well as set personal options such as Do Not Disturb.
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Chapter 1
Installing Amanda Clients

Installing Amanda Messenger and Amanda 
Dialer

The Amanda Messenger and Amanda Dialer applications must be installed 
on each user’s workstation. They can be installed from a network drive if 
your Amanda system administrator or your network administrator copies the 
files on the User Clients disk to a network location. They run on Windows 
3.11, Windows 95, 98, NT, or 2000.

To install Amanda Messenger or Amanda Dialer:

1. Run SETUP.EXE from the User Clients disk or from the location on 
your network where the disk has been copied. You can do any of the 
following:

• Double-click the name of this file in File Manager (Windows 3.11) 
or Explorer (Windows 95).

• Select Run… from File Manager’s File menu or from Windows 
95’s Start menu. Then type the path to SETUP.EXE in the text box 
or click Browse… to locate SETUP.EXE.

The Setup dialog box appears.

2. Click Continue.

The Installing Amanda Clients dialog box appears.

3. Click Yes.
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The Destination Path dialog box appears.

Use the default path (C:\AMACLNTS) for the Amanda Clients or type 
(or browse for) another path in the Path text box.

4. Click Continue.

The Destination Group dialog box appears.

5. Use the default group (Amanda) or type a new group name in the Group 
text box.

Click Continue.

Installing Amanda Fax
Install Amanda Fax only after you have installed the Amanda Messenger and 
Amanda Dialer software. That installation process automatically installs the 
SENDFAX.EXE file that is required by Amanda Fax.

In Windows 3.11
To install Amanda Fax in Windows 3.11:

1. From Program Manager’s Main group, double-click the Control Panel 
icon.

The Control Panel group appears.

2. Double-click the Printers icon. 

The Printers dialog box appears. 

3. Click Add>>.

The dialog box expands.

4. In the List of Printers list box, select Install Unlisted or Updated 
Printer—if it isn’t already selected.

5. Click Install….
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The Install Driver dialog box appears. 

6. Do one of the following:

• If you are installing from a floppy disk, insert the 
Amanda@Work.Group User Client floppy disk into a floppy disk 
drive. Make sure that the name of the drive containing the floppy 
disk appears in the text box. (For example, if you inserted the 
floppy disk in the A: drive, A:\ appears in the text box.) Go on to 
step 7.

• If you are installing from a network location, click Browse… and 
use the Browse dialog box to locate the files from the 
Amanda@Work.Group User Client disk. (Windows 3.11 is looking 
for the directory that stores the OEMSETUP.INF file. Ask your 
Amanda system administrator for the exact path to this directory, if 
necessary.) 

Click OK to return to the Install From Disk dialog box.

7. Click OK to exit from the Install Driver dialog box.

The Add Unlisted or Updated Printer dialog box appears. Its List of 
Printers list box should display (and have already selected) Amanda 
Fax.

8. Click OK.

The Printers dialog box reappears. The Installed Printers list box should 
now include Amanda Fax on LPT1 (or a similar listing).

9. Click Close.

In Windows 95 or 98
To install Amanda Fax in Windows 95:

1. From the Start menu, select Settings then Printers.

The Printers window appears.

2. Double-click the Add Printers icon.
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The Add Printer Wizard dialog box appears.

3. Click Next.

4. Select the Local Printer option button—if it is not already selected.

5. Click Next.

6. Click Have Disk…

The Install From Disk dialog box appears. 

7. Do one of the following:

• If you are installing from a floppy disk, insert the 
Amanda@Work.Group User Client floppy disk into a floppy disk 
drive. Make sure that the name of the drive containing the floppy 
disk appears in the Copy Manufacturer’s Files From text box. (For 
example, if you inserted the floppy disk in the A: drive, A:\ appears 
in the text box.) Go on to step 8.

• If you are installing from a network location, click Browse… and 
use the Open dialog box to locate the files from the 
Amanda@Work.Group User Client disk. (Windows 95 is looking 
for the folder that stores the OEMSETUP.INF file. Ask your 
Amanda system administrator for the exact path to this folder, if 
necessary.) 

Notice that you cannot select a file from this Open dialog box. 
_OSETUP.INF appears to be selected, but that is not the case. Win-
dows 95 is concerned only with the selected folder (from which it 
automatically selects OEMSETUP.INF—even though that does not 
appear to be the case). 

Click OK to return to the Install From Disk dialog box.

8. Click OK to exit the Install From Disk dialog box.

The Add Printer Wizard dialog box reappears. Amanda Fax appears in 
the Printers list box.

9. Click Next.
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10. Select the FAX port (or any port other than FILE) from the Available 
Ports list box.

NOTE: The port selection is unimportant because Amanda 
Fax does not use a port on this machine. Your selection 
only affects the icon in the Printers group. Your selec-
tion does NOT affect any other application or printer 
configuration.

11. Click Next.

12. You probably do NOT want Amanda Fax as your default printer and 
should select the No option button. If you plan to use Amanda Fax as 
the default printer, select the Yes option button instead.

13. Click Next.

14. Click Yes to send a test fax page.

15. Click Finish.

The Amanda Fax dialog box appears.

16. Do one of the following:

• To send the test page to your fax machine, select Fax Out then click 
OK.

You are asked for your mailbox and security code, then a fax num-
ber.

• To send the test page as a message, select Send to Messenger… 
then click OK.

You are asked for your Amanda Messenger mailbox.

Within Amanda Messenger, click the Compose window to make it 
active, double-click the fax component to view the page.

17. If the test page is OK, click Yes in answer to the question about that in 
the Amanda Fax dialog box.
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Chapter 2
Using Amanda Messenger

Logging On to Amanda Voice Server
Amanda Messenger provides a workstation interface for managing 
messages. It is easier to use and has more options than are available when 
using a touch-tone telephone. 

When you start Amanda Messenger, you must log on to the Amanda Voice 
Server.

To use Amanda Messenger:

1. Double-click the Amanda Messenger icon. In Windows 95, you can 
select Amanda Messenger from the Start menu.

The Messenger Logon dialog box appears.

2. Click Network Settings…. 

The Network Settings dialog box appears. Its default settings, which are 
AMANDASERVER for the Server Name and 0 for Local Area Network 
Adapter (LANA), are accurate in most cases. See your system adminis-
trator to be sure.

3. Click OK.

The Messenger Logon dialog box reappears.

4. Type your mailbox in the Mailbox text box.
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Your mailbox is probably the same as your extension number, but it 
doesn’t have to be. Check with your system administrator to be sure.

5. Type your security code in the Security Code text box.

(This is the same security code that you use to access Amanda over the 
telephone.)

6. Click OK.

Amanda Messenger appears. Its main window contains:

Logging Back On
If you lose connection to Amanda Voice Server while you are using Amanda 
Messenger, you can log back on without exiting Amanda Messenger.

To log back on to Amanda Voice Server:
• On the System menu, click Log On.

A message indicates that you are logged on or that the server is unavail-
able.

More Than One Logon
Using Amanda Messenger, more than one user can log on to the same 
mailbox at the same time—as long as they all know its security code. For 
example, if customers who call when all the lines are busy can choose to 
leave a message, customer service representatives might all monitor the 
mailbox that stores those messages. On busy days, some employees may be 
answering calls, while others process the oldest messages that have been left. 

New Messages window Lists all unheard messages and any that 
were not saved or deleted after having 
been heard.

Saved Messages window Lists all previously heard messages.

Trash Bin window Lists all deleted messages.

Message Statistics Displays read-only information about 
your mailbox.
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To prevent others from processing the same messages, employees must 
remove messages from the New Messages window as they start to process 
them. The supervisor can use Amanda Messenger to monitor that mailbox, 
determining how to schedule employees’ time, when to answer messages 
along with the others, and so forth.

Changing Your Security Code
As you start Amanda Messenger, you are prompted for your security code. 
Amanda Messenger uses that code to log you on to Amanda Voice Server. 
Once logged on, you can listen to your messages, send messages, and so 
forth.

It is a good idea to change your security code occasionally. You can change 
it at any time. Use up to eight digits. Security codes are always numeric so 
they can be entered using a touch-tone telephone.

To change your security code:

1. On the Options menu, click Security Code….

The Change Security Code dialog box appears. For security reasons, the 
dialog box does not display security codes.

2. Type your current code in the Current Security Code text box.

Asterisks appear as you type.

3. Type the new code in the New Security Code text box.

4. Confirm the new security code by retyping it into the Verify New Secu-
rity Code text box.

Message Windows
The message windows (New Messages, Saved Messages, and Trash Bin) list 
messages for each mailbox.
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Amanda Messenger puts every incoming message in the New Messages 
window. In general, you should use this window only for messages that you 
haven’t played or, in the case of fax messages, haven’t viewed. However, 
unless new messages are automatically saved, the New Messages window 
lists any messages that you have not saved or deleted, regardless of whether 
you have played or viewed them. While there are messages in this window, 
your message light (if you have one) remains on, so it is important that you 
move messages to the Saved Messages or the Trash Bin window. On the 
Messages menu, you can click Update Messages to save the messages that 
have been listened to or viewed all at once.

The Saved Messages window is for messages you want to keep for a while. 
For example, they may contain information you need to get your job done. 
Depending on the workstation options you set, Amanda Messenger may 
automatically save every new message as you play or view it.

The Trash Bin window lists messages that you no longer want. You put them 
there, but, while the messages are still in the Trash Bin window, you can 
change your mind and move them to the Saved Messages window. 
Unwanted messages are permanently deleted as you exit Amanda 
Messenger.

By default, the oldest message is at the top of each list and the newest 
message is at the bottom (sorted by date and time).
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Understanding Information Columns
Each message window contains five columns:

Date Displays the date associated with the message. Depend-
ing on Amanda Voice Server options, it is either the date 
the message was recorded or the date the message was 
forwarded. This column sorts in ascending (oldest to 
newest) order.

From Displays one of the following:
The mailbox and/or name of the Amanda user who is con-
tacting you. What information you see here depends on 
the workstation options you have set.
The word “Outside” if the call originated outside the 
Amanda system.
This column sorts in alphanumeric order.

Attributes Displays additional message markings: Urgent, Private, 
Receipt
Urgent: Indicates that the caller who recorded the mes-
sage marked it urgent. 
Private: Indicates that the caller who recorded the mes-
sage marked it private (so it cannot be forwarded).
Receipt: Indicates that the message you sent to a cowork-
er (along with a request for verification) was heard or 
viewed. 
This column sorts from highest to lowest: Urgent, Private, 
Receipt, none
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Resizing and Reordering Columns
You can adjust the width of columns and reorder them for convenience. For 
example, you might want the Subject column to be wider and be the third 
column.

To adjust a column’s width:
• Position the mouse pointer over the separator to the right of the col-

umn and drag the separator horizontally to change the column’s 
width.

This changes the size of the column preceding the separator and the last 
column.

To hide a column:
• Position the mouse pointer over the separator to the right of the col-

umn and drag the separator to the left as far as possible.

To hide the last column, widen the second-to-last column.

Length Displays one of the following: 
For a one component voice message, displays the total 
length in seconds.
For a one component fax message, displays the total num-
ber of pages.
For a multi-component message, displays the total num-
ber of components. A multi-component message can con-
tain both fax and voice messages.
This column sorts in ascending numerical length.

Subject Displays the subject (up to 50 characters) of the message. 
To add or edit a subject, do one of the following:
On the Messages menu, click Edit Subject…. 
Double-click the Subject column for the message.
This column sorts in alphanumeric order.
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To reorder the columns:
• Position the mouse pointer over the column header and drag it to the 

column’s new position. 

Sorting Rows
By default the rows are sorted by date, but you can sort them based on the 
data in any column. For example, you might want to sort them by who they 
are from so you can review all the messages from a particular person more 
easily.

To sort the rows:
• Click a header to sort the messages based on the contents of that col-

umn. 

This column becomes the primary sort column. The previous primary 
sort column becomes the secondary sort column, and so on.

The number to the right of the header indicates the column’s order in the 
sort: 1 indicates the primary sort column, 2 indicates the secondary sort 
column, and so on.

To create a secondary sort:

1. Click the column header for the column on which the secondary sort is 
to be based. 

2. Click the column header for the column on which the primary sort is to 
be based. 
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Setting Up Amanda Messenger
To make sure that Amanda Messenger operates the way you want it to, you 
need to set workstation options.

To set up Amanda Messenger:

1. On the Options menu, click Workstation Options….

The Workstation Options dialog box appears.

2. Set any of the workstation options explained in the following sections.

Setting Play/Record Options
To play messages and to record greetings and messages, Amanda Messenger 
needs information about your telephone extension and how you plan to use 
your workstation’s sound card.

To set up Amanda Messenger for playing and recording:

1. From the Workstation Options dialog box, type your extension or the 
digits Amanda Messenger should dial to reach you in the Extension text 
box.

2. Select the Wait for Answer check box to make Amanda wait for a voice 
response before playing or recording. Clear it to avoid a wait if, for 
example, your telephone switching system does not allow Amanda to 
wait for an answer.

3. Select the Use Speakers option to play messages from your workstation. 

When cleared, the play functionality on your workstation is disabled and 
Amanda Messenger calls you on the telephone to play your messages.

4. Select the Use Microphone option if you want to record using your 
workstation. For example, sound can reach the sound card via your 
workstation’s microphone or CD ROM drive. 

When cleared, Amanda Messenger calls you on the telephone to record 
greetings and messages.
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Converting from Stereo to Mono
When importing a stereo .WAV file, it must be converted to mono. You 
select the stereo channel on which to base its conversion.

To select a stereo import conversion channel:
• From the Workstation Options dialog box, click one of the following 

option buttons:

• Left Channel 

• Right Channel

• Average of Both

Being Notified about New Messages
If Amanda Messenger is running (even in the minimized mode), it can notify 
you every time a new message is received by displaying a message on your 
workstation.

To be notified about new messages by Amanda Messenger:
• From the Workstation Options dialog box, select the Notify about 

New Message check box. Clear the check box to avoid this type of 
notification.

Displaying Mailbox Names
You can control how mailboxes and their names (the contents of both 
Directory Name 1 and Directory Name 2) are displayed in Amanda 
Messenger. 

Select one of the following option buttons: 
Mailbox Followed by Name Displays both the name and the mailbox, 

with the mailbox first. 
Name Followed by Mailbox Displays both the name and mailbox, with 

the name first. 
Mailbox Only Displays only the mailbox. 
Name Only Displays only the name. 
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Your selection determines the order a mailbox and name is displayed in the 
From column in the New and Saved Messages windows and in user lists. 
Regardless of your selection, if there is no name, Amanda Messenger 
displays only the mailbox. 

Saving New Messages Automatically
Normally new messages stay in the New Messages window until you move 
them to either the Saved Messages or the Trash Bin window using drag-and-
drop or either the Save or Update Messages commands on the Messages 
menu.

However, Amanda Messenger can move messages to the Saved Messages 
window for you automatically as soon as they are heard or viewed.

To save messages automatically:
• From the Workstation Options dialog box, select the Autosave New 

Message check box. Clear the check box to save messages manually. 

NOTE: If you listen to a message using the telephone, the message 
is automatically moved to the Saved Messages window 
with or without this option.

Prompt to Empty Trash Bin on Exit
Amanda Messenger automatically deletes all the messages in the Trash Bin 
window as you exit. When you exit, Amanda Messenger can remind that the 
messages in the trash bin will be deleted and allow you to cancel the exit. 

To exit Amanda Message with or without the reminder:
• From the Workstation Options dialog box, select the Prompt to Emp-

ty Trash Bin on Exit check box to be notified that messages will be 
deleted if you exit. Clear the check box to exit (and delete the mes-
sages) without the reminder.
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Managing Messages
This section explains how to handle both voice messages and fax messages.

Playing or Viewing a Message
As you receive voice or fax messages, your message light goes on and your 
workstation prompts you (unless you have stopped new message 
notification). You, of course, will want to review them.

To play a voice message or view a fax message:
• Double-click the message.

You can also select the message and click Play on the Play menu, View Fax 
on the Fax menu, or Play from the player controls.

NOTE: Double-clicking the subject column for a message displays 
the Edit Subject dialog box.

Saving a Message
Depending on the workstation options you set, Amanda Messenger may 
automatically save every new message after you play it. Otherwise, to save a 
message, you must move it from the New Messages window or the Trash 
Bin window to the Saved Messages window.

To save messages manually, do one of the following:
• Drag the messages to the Saved Messages window.
• Select the messages. Then, on the Messages menu, click Save.
• On the Messages menu, click Update Messages to move all the mes-

sages that have been listened to or viewed to the Saved Messages 
window. In this case, you do not need to select them.

• Move the messages by copying them from the original window and 
pasting them in the Saved Messages window. 

Copy and Paste are on the Edit menu and the toolbar:

Copy  and Paste .
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NOTE: Copying messages results in a move if the destination 
is a message window. It results in a copy if the destina-
tion is a Compose window.

To save new messages automatically, see “Saving New Messages 
Automatically” on page 16.

Deleting a Message
You move selected messages from the New Messages or Saved Messages 
window to the Trash Bin window when you no longer want those messages.

To put messages in the trash bin, do one of the following:
• Drag the messages to the Trash Bin window.
• Select the messages. Then, on the Messages menu, click Delete.
• Select the messages. Then, press the Delete key.
• Move the messages by copying them from the original window and 

pasting them in the Trash Bin window.

While the messages are still in the Trash Bin window, you can rescue them.

NOTE: Copying messages results in a move if the destination 
is a message window. It results in a copy if the destina-
tion is a Compose window.

To rescue messages from the trash bin, see “Saving a Message” on page 17.

To permanently delete messages, you empty the Trash Bin window or exit 
Amanda Messenger.

To empty the trash bin, do one of the following:
• From the Messages menu, click Empty Trash Bin.
• Allow the trash to be emptied automatically as you exit Amanda 

Messenger.
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Composing a Message
You can record a new message or a component for a new message using your 
telephone or your workstation. Your workstation options indicate what 
device you use to record. You can also add a component from an existing 
message or import an existing .WAV file as a component.

To use your telephone or your workstation:

1. On the Options menu, click Workstation Options….

The Workstation Options dialog box appears.

2. Do one of the following:

• Select the Use Microphone check box to record messages using 
your workstation. For example, you can record messages by speak-
ing or playing music into a microphone, from a CD, and/or via your 
in-line jack.

• Clear the Use Microphone check box to record messages using 
your telephone.

To record a message using the telephone:

1. On the Messages menu, click New Message.

An empty Compose window appears.

2. On the Play menu, click Record.

Your extension rings.

3. Answer the telephone and Amanda will prompt you through the record-
ing process.

After you save the recording, its component number appears in the 
active window. 

TIP: You can start with step 2. When you save the recording, a 
Compose window is created automatically if no Compose 
window is active.
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To record a message using the workstation’s sound card:

1. On the Messages menu, click New Message.

An empty Compose window appears.

2. On the Play menu, click Record.

3. Immediately start speaking into the microphone or playing a CD (or 
other device) for .WAV files.

4. On the Play menu, click Stop.

The Approve or Reject dialog box appears.

5. Click Review to listen to your recording.

6. Click Save to save it or Cancel to reject it. If you reject the recording, 
redo steps 2 through 6.

The number for the recorded component appears in the Compose win-
dow. 

TIP: You can start with step 2. When you save the recording, a 
Compose window is created automatically if no Compose 
window is active.

To create a message using components from other messages:

1. On the Messages menu, click New Message.

An empty Compose window appears.

2. From a message window, right-click a message that contains a compo-
nent to be used in the new message.

A Message Components window lists (by number) the components in 
the selected message.

You can double-click a component to play it.

3. Drag one or more of the components from the Message Components 
window to the Compose window. (Or use the Copy and Paste.)
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4. Repeat steps 2 and 3 for any other messages that have components to be 
used in the new message.

TIP: To use the entire message as part of the new message, you 
can drag it directly from the message window to the Com-
pose window.

Using Message Components
Every message contains from 1 to 20 components. For example, if a message 
is forwarded from one mailbox to another, it may have two components: the 
original message and the prefix recorded by the person who forwarded the 
message. If that same message is forwarded to another mailbox with another 
prefix, it will contain three components.

To list a message’s components, do one of the following:
• Right-click on the message 
• Select the message. Then, on the Messages menu, click Show Com-

ponents.

A Message Components window lists (by number) the components in 
the selected message. You can do any of the following:
• Double-click a component to play it.
• Copy components to a Compose window by dragging them to 

the new window or by using Copy and Paste. 

Sending a Message
Your message includes all the components in the active Compose window. 
You can send it to only one of the following:
• Individual users
• Personal mailing lists
• System mailing lists

For example, to send a message to two individuals, two personal mailing 
lists, and one system mailing list, you need to send the message three times.
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To send a message that has been composed:

1. Select the Compose window that contains the message to be sent.

2. On the Messages menu, click Send….

The Message Send Information dialog box appears.

3. Indicate whether you are sending the message to a mailbox or a list of 
mailboxes by selecting the Mailboxes, Personal List, or System List 
option button.

When you make your choice, the list box to the right of the option but-
tons changes to display mailboxes, personal mailing lists, or system 
mailing lists.

4. Do one of the following:

• If you selected the Mailboxes option button, select one or more 
mailboxes. 

You can type the first mailbox number in the text box above the list. 
If the name is displayed before the mailbox, type the first few letters 
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of the user’s name. (This is faster than scrolling to find a recipient 
for your message.)

• If you selected the Personal List or System List option buttons, 
select one or more of the lists displayed in the list box.

TIP: Double-click a mailbox or list to immediately send the 
message to that mailbox or list. To send to more than 
one mailbox or more than one list, use multiple selec-
tion (using Shift+click or Ctrl+click) then click OK.

5. Select any combination of the following check boxes:

• Select Urgent to mark the message as urgent.

• Select Private to make your message unforwardable.

• Select Return Receipt Request to receive a message from Amanda 
when each recipient plays the message. It is also shown as an 
attribute of the message in Amanda Messenger.

6. Type a subject for the message (up to 50 characters) in the Subject text 
box.

7. Click When to Send if you want to send the message at a future date and 
time.

The Future Delivery Date and Time dialog box appears.

8. Type or use the spin boxes to select the delivery date and time.

If you select a date or time in the past, Amanda delivers the message 
immediately.

9. Click OK to return to the Message Send Information dialog box.

Forwarding a Message
You can forward more than one message as one message. You can forward it 
exactly as it is with no prefix, or you can forward it with a prefix and other 
additional components.
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To forward a message exactly as it is:

1. Select the message or messages to be forwarded from a message 
window.

2. Do one of the following:

• Click Forward Immediately on the toolbar.

• On the Messages menu, click Forward Immediately….

The Message Send Information dialog box appears.

3. Indicate whether you are sending the message to a mailbox or a list of 
mailboxes by selecting the Mailboxes, Personal List, or System List 
option button. 

When you make your choice, the list box to the right of the option but-
tons changes to display mailboxes, personal mailing lists, or system 
mailing lists. 

Do one of the following:

• If you selected the Mailboxes option button:
a. Select one or more mailboxes.
b. Type the first mailbox number in the text box above the list. 

If the name is displayed before the mailbox, type the first 
few letters of the user’s name. (This is faster than scrolling 
to find the first recipient for your message.)

• If you selected the Personal List or System List option buttons, 
select one or more of the lists from the list box. 

TIP: Double-click a mailbox or list to immediately send the 
message to that mailbox or list. To send to more than 
one mailbox or more than one list, use multiple selec-
tion (using Shift+click or Ctrl+click) then click OK.

4. Select any combination of the following check boxes:

• Select Urgent to mark the message as urgent.

• Select Private to make your message unforwardable.
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• Select Return Receipt Request to receive a message from Amanda 
when each recipient plays the message. It is also shown as an 
attribute of the message in Amanda Messenger.

5. Type a subject for the message (up to 50 characters) in the Subject text 
box.

6. Click When to Send if you want to send the message at a future date and 
time.

The Future Delivery Date and Time dialog box appears.

7. Type or use the spin boxes to select the delivery date and time.

If you select a date or time in the past, Amanda delivers the message 
immediately.

8. Click OK to return to the Message Send Information dialog box.

To forward a message with a prefix or other additional components:

1. Select the message or messages to be forwarded from a message 
window.

2. On the Messages menu, click Forward….

The Prefix Message dialog box appears.

3. Click Record.

If you are using a sound card and microphone, speak into the micro-
phone and click Stop when you have finished. The Approve or Reject 
dialog box appears. Use it to review, save, or cancel your prefix.

If recording through the telephone, Amanda rings your extension and 
says, “Begin recording at the tone. Finish by pressing # or hanging up.” 
If you finish by pressing #, Amanda allows you to review the recording, 
append it to the previous recording, or reject it.

A Compose window displays the components of the message to be for-
warded preceded by the component you just recorded. Each component 
has a ten-digit number that identifies it. An icon and the word Voice 
appears to the left of the number. (This window is not active.)
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4. After saving your prefix, the Message Send Information dialog box 
appears.

5. Follow steps 3 through 8 in the above procedure “To forward a message 
exactly as it is.”

To record an additional component:

1. On the Play menu or from the player controls, click Record.

After you approve the recording, a component appears in the Compose 
window.

2. You can repeat step 1 to create additional recorded components. For 
example, you might create a prefix and a postfix for a component copied 
from another message.

To copy a component from another message:

1. Right-click the message.

2. A Message Components window appears.

3. Copy one or more components from the window.

4. Paste the components into the Compose window.

5. You can repeat steps 1 through 3 to copy components from other mes-
sages.

To import a .WAV file as a message component:

1. On the Messages menu, click Import Message....

The File Open dialog box appears. 

2. Use this dialog box to locate the .WAV file then click OK. 

3. You can repeat steps 1 and 2 for additional .WAV files.
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To import an image file as a message component:

You can import .TIF, .DCX (multiple-page .PCX), and other image files into 
Amanda Messenger and then send them as fax messages to coworkers. If 
you created a file from another application, such as Microsoft Word, using 
the Amanda Fax Driver, that file has the .FAX extension and can also be 
imported.

1. Do one of the following:

• Click Open Fax  on the toolbar.

• On the Fax menu, click Open....

The File Open dialog box appears.

2. Use the dialog box to select the file to be viewed then click OK.

The image appears in a window. 

3. On the Fax menu, click Import Fax.

The image file is converted to a fax component. The component number 
appears in a new Compose window.

4. Drag the new component to the Compose window where you are creat-
ing your message.

Replying to a Message
When you reply to a message sent to you by someone on the Amanda 
system, Amanda Messenger automatically addresses your reply to that 
person. 

To reply to a message:

1. Select the message to be replied to.

2. On the Messages menu, click Reply.

An empty Compose window appears.
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3. On the Play menu or player controls, click Record and record your 
response.

See “Composing a Message,” earlier in this chapter, for more informa-
tion.

4. On the Messages menu, click Send….

Amanda Messenger addresses the message for you.

See “Sending a Message,” earlier in this chapter, for more information.

Managing Fax Messages
You can view fax messages, rotate their pages, print them, and save them as 
image files using .TIF (Group 3) or .DCX format. You can also open .TIF or 
.DCX files for viewing in Amanda Messenger. Once it is open, you can 
import it as a fax message.

If a fax message was sent to you from an internal source, you can forward it 
and reply to it. See the “Forwarding a Message” and “Replying to a 
Message” sections, earlier in this chapter.

To view a fax message, do one of the following:
• Double-click the selected fax in a message window.
• Select the message. Then, on the Fax menu, click View Fax.
• Select the message. Then, on the Play menu, click Play.
• Select the message. Then, on the Player control toolbar,

 click Play .

Amanda Messenger displays the selected fax message in a new Fax window. 
Each page is represented as a small thumb-nail-sized rectangle called a 
“thumbnail.” Click the first thumbnail to view the first page. Click it a 
second time to return to the thumbnail.

After displaying a fax, click Rewind or Fast Forward on the player controls 
toolbar to move to the previous and next pages. 
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To rotate the pages in a fax message:

1. On the Fax menu, click Rotate Fax….

The Rotate Fax dialog box appears.

2. Select an option button to rotate all the pages in the message:

• 90 degrees (clockwise or counter-clockwise)

• 180 degrees (upside-down)

• Around the x-axis (mirror image)

• Around the y-axis (upside-down mirror image)

To print all or part of a fax message:

1. On the Fax menu, click Print….

The Print dialog box appears.

2. Do one of the following:

• Select the All option button to print the entire fax message.

• Select the Pages option button and supply a range of pages.

3. Set any other options that are appropriate (such as number of copies).

4. Click Setup to change printer options if necessary.

(You can also change printer options by selecting Print Setup… from 
the Fax menu.)

NOTE: You can preview the message before printing it. (On the 
Fax menu, click Print Preview.) From the preview window, 
you can print the fax after viewing its pages one at a time 
or in pairs. You can magnify pages for better viewing, but 
you cannot rotate them.
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To save a fax message as a .TIF or .DCX file:

1. On the Fax menu, click Save As….

The File Save As dialog box appears.

2. Provide a name and location for the new file.

If the extension is not .TIF or .DCX, the Verify Save Type dialog box 
asks you what format the file has.

To view a .TIF or .DCX file in Amanda Messenger:

1. On the Fax menu, click Open….

The File Open dialog box appears.

2. Provide the name and location for the file then click OK.

A window displays the pages of the file. The file’s name appears in the 
title bar.

To import an image file as a fax message:

1. On the Fax menu, click Open….

The File Open dialog box appears.

2. Provide the name and location for the file then click OK.

A window displays the pages of the file. The file’s name appears in the 
title bar.

3. On the Fax menu, click Import Fax.

Amanda Messenger converts the image file to a message and displays its 
component number in a Component window. 

Now you can send it.
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Managing Mailing Lists
You can create up to seven personal mailing lists. 

To create or edit a list:

1. On the Options menu, click Personal Lists….

The Personal Lists dialog box displays three list boxes:

• The seven possible lists in the Lists box

• The mailboxes for all possible users in the All Possible list box 

• The mailboxes currently on the list in the Current List box

2. Type or select the number of the list to be created or edited.

3. Double-click mailboxes in the All Possible list box to add them to the 
Current List box (if they are not already on the list).

4. Double-click mailboxes in the Current List box to remove them from 
the list.

TIPS: To add more than one mailbox to the list at one time, 
select the mailboxes to be added from the All Possible 
list box, then click >>Add>>.
To remove more than one mailbox from the list at one 
time, select the mailboxes to be removed from the Cur-
rent list box, then click <<Remove<<.
After selecting the list box that contains the list num-
ber or mailbox, type the first character in the list or 
mailbox. Amanda Messenger immediately goes to the 
first entry that begins with the character you typed. 
Type that character again to go to the next match.

5. (Optional) To give the list a name to remind you of its contents, click 
Edit List Name….

The Edit Personal List Name dialog box appears.

6. Type a name for the list in the List Name text box. 

You can use up to 71 characters, but the Lists box displays about 15.
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To empty a list:

1. On the Options menu, click Personal Lists….

2. Select the number of the list to be emptied.

3. Click Empty List.

Viewing Message Statistics
The Message Statistics window display statistics about your messages.

Controlling Call Processing
Your system administrator sets most of the options that control how your 
calls are processed. You can:
• View these options from your workstation
• Reset those that your administrator allows you to
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You can reset these options using your telephone as well as Amanda 
Messenger. For more information, see Using Amanda@Work.Group 
Telephone Features.

• Request changes to be made by the administrator

Changing Basic Options
You can view and often change your mailbox’s basic options. For example, 
you can:
• Always control options such as whether Amanda plays the date and 

time
• Control options such as Do Not Disturb only when your system ad-

ministrator has not locked those features
The options that you can control can be changed using Amanda Messenger 
or using the telephone. For more information, see Using Amanda@Work.Group 
Telephone Features.

To view basic options:
• On the Options menu, click Basic Options…

The Basic Options dialog box displays the options that are described in 
the following table.



34 Using Amanda@Work.Group/DOS Workstation Features
Basic Options
Option Description

Do Not Disturb When this check box is selected, Amanda plays the Ring No Answer 
(RNA) greeting without trying to call you. When cleared, Amanda 
performs the programmed dial actions in the Extension text box. Usu-
ally, this calls your extension.

Call Screening  You can screen calls if the following conditions exist:
• This option is selected
• Do Not Disturb is cleared
• The System Administrator has configured Amanda to per-

form supervised transfers
Amanda asks the caller, “At the tone, please say your name and com-
pany.” The caller’s response is played for you when you answer the 
telephone. You accept or reject the call based on who is calling. 

If a mailbox has both Call Screening and Identify Called Party select-
ed, you hear one of the following (depending on options set by your 
system administrator):
• Only the mailbox that the call is for. Callers are not asked for 

their name and company. In this way, you can accept or reject 
the call based on the called party. (This is designed for exten-
sions that receive calls for more than one user, department, and 
so forth.) 

• Both the mailbox and the caller’s name and company. This al-
lows you to accept or reject the call after hearing information 
about both the caller and the called party.
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Managing Waiting Calls
 If a call arrives while you are using your extension and you use the Manage 
Waiting Calls feature, the Waiting Calls dialog box appears on your 
workstation. 

Identify Called Party When this check box is selected and Amanda performs a supervised 
transfer, Amanda plays the Name and Extension recording of the 
mailbox that was called. This is useful when two or more mailboxes 
ring the same telephone extension. (Messages are stored with the 
mailboxes, so each user’s messages are private.)
When Identify Called Party is cleared, she plays a connection tone 
that only the called party can hear before she connects the caller. 

NOTE:  If the Extension text box in the General Mailbox Information 
dialog box indicates an unsupervised transfer (for example, 127H), 
Identify Called Party is not available.

Play Date & Time When this check box is selected and a message is played, Amanda 
plays the date and time when that message was recorded followed by 
the message itself. When cleared, the date and time are not played. 

NOTE:  If you are listening to the message over the telephone, you can 
press 74 at any time during the message to hear its date—even if this 
option is cleared.

Basic Options (Continued)
Option Description
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Use it to:
• Connect to the waiting caller (after you terminate the current call)
• Transfer the caller to a coworker
• Place the caller on hold
• Have Amanda take the caller’s message

Preparing for Waiting Calls
For minimal preparation for managing waiting calls, perform steps 1 through 
3 of the following procedure. While this is the simplest way to set up for 
waiting calls, remember:
• You have only a few seconds to respond to a waiting call after 

Amanda notifies you about it. After the time expires, Amanda treats 
your waiting call as though Manage Call Waiting was not being used 
and puts the caller on hold.

NOTE: The amount of time depends on the setting for the 
tmo_call_screening configuration option set by your 
Amanda system administrator—although you can re-
duce the number of seconds.

• Your caller waits while you notice that you have a waiting call and 
while you decide what to do with it.

It is best to make complete preparations for waiting calls.

To set up Amanda Messenger so that you can manage waiting calls:

1. On the Options menu, click Workstation Options….

The Workstation Options dialog box appears.

2. Select Use Speakers so you can play the name and company after your 
caller records it (if you have a sound card).

3. Select Manage Waiting Calls so the Waiting Calls dialog box appears on 
your workstation when your extension is busy and another call arrives.

4. Click Notification… to control how Amanda Messenger notifies you 
about calls that arrive while your extension is busy.

The Notification Options dialog box appears.
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5. By default, the Waiting Call dialog is made active, even if Amanda 
Messenger is minimized. It is best to keep Make Window Active and 
Restore if Minimized selected. 

• To hear a beep, select beep then click OK.

6. Click Configuration… to streamline the way waiting calls are pro-
cessed. Save yourself (and your caller) time by deciding in advance 
about:

• Which greeting to play when you want to:

• Put the caller on hold

• Have the caller leave a message

• Transfer the caller to a coworker

• Which coworker to transfer calls to or which coworkers to put on 
your personal transfer list

Use the following procedures to set the remaining options you need.

To specify greetings for waiting calls:

1. Click Configuration….
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The Waiting Call Configuration dialog box appears.

2. Click the Edit... button beside the type of response: Hold Greeting, Take 
Message Greeting, or Transfer Greeting.

The Hold Greeting, Take Message Greeting, or Transfer Greeting dialog 
box appears.

3. Select one of the entries in the Greeting List box.

Selecting Prompt (the default) allows you to postpone a decision about 
what greeting to play until after the call arrives. 

(Use this if you have more than one greeting for a hold, for message tak-
ing, or for transferring. For example, if you transfer one type of call to 
one coworker and another type of call to another coworker, you might 
have a separate greeting for each type of call.)

In the Hold Greeting dialog box, you can select the custom busy greet-
ing in addition to one of the seven RNA greetings.

Amanda Messenger will automatically play this greeting whenever you 
respond to a waiting call with this type of response.

4. Repeat steps 2 and 3 for other types of call responses.



Chapter 2 Using Amanda Messenger 39
To specify a single coworker:

1. Click Configuration….

The Waiting Call Configuration dialog box appears.

2. Click the Edit... button beside Transfer to Mailbox.

The Transfer Mailbox dialog box appears.

3. Select the mailbox (or select prompt to postpone the selection of a mail-
box until after the call arrives).

Amanda Messenger will transfer all the waiting calls that you decide to 
transfer to this mailbox.

To create a personal list of mailboxes to which you transfer calls:

1. Click Configuration….

The Waiting Call Configuration dialog box appears.

2. Select one or more mailboxes from the Mailbox List box.

3. Click >>Add>> to add them to the Personal List box.

Amanda Messenger will display this list when you decide to transfer a 
waiting call.

TIP: Double-click a mailbox to immediately add it to the 
Personal List box. 
To remove a mailbox from the Personal List box, dou-
ble-click it.
To remove more than one at a time, select them then 
click <<Remove<<.

To reduce the amount of time you have to manage the call:

1. Click Configuration….

The Waiting Call Configuration dialog box appears.

2. Clear the Default check box.

The Time Out text box becomes enabled.
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3. Type a number of seconds in the text box.

Managing a Call after Minimal Preparation
The following procedures explain how to use Manage Waiting Calls without 
doing any preplanning. A little preparation on your part can save you steps 
and, more importantly, time. You have only a few seconds to manage the call 
before Amanda places it on hold—just as she does without Manage Waiting 
Calls.

To listen to the name and company name of your caller:

1. From the Waiting Calls dialog box, click Play Name.

Note: Play Name is not available if Use Speakers is not a se-
lected workstation option.

2. Do one of the following procedures.

To place this waiting call on hold:

1. From the Waiting Calls dialog box, click Hold.

The Hold Greeting dialog box appears.

2. Select the greeting that Amanda will play to your caller from the Greet-
ing list box.
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3. Click Hold.

After the hold, the Waiting Calls dialog box reappears so you can pro-
cess this call again.

TIP: Configure Manage Waiting Calls to use either your custom 
busy greeting or a specially recorded hold greeting (one of 
your RNA greetings) automatically.

To connect yourself to the caller:
• From the Waiting Calls dialog box, end your current call then click 

Connect.

To have the caller leave a message:

1. From the Waiting Calls dialog box, click Take Message.

The Take Message Greeting dialog box appears.

2. Select the greeting that Amanda will play to your caller from the Greet-
ing list box.

3. Click Take Message.

TIP: Configure Manage Waiting Calls to use either your usual 
RNA (Ring No Answer) greeting or a specially recorded 
take-message greeting (one of your RNA greetings) auto-
matically. 
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To transfer this call to a coworker:

1. From the Waiting Calls dialog box, click Transfer.

The Transfer Greeting dialog box appears.

2. Select the greeting that Amanda will play to your caller from the Greet-
ing list box.

3. Click Transfer.

The Transfer Waiting Call dialog box displays all the mailboxes on the 
Amanda system.

TIP: Configure a mailbox for all transfers or make a transfer 
list so you can select from a smaller list instead of all 
the mailboxes in the Amanda system. (If you have a 
personal transfer list, you can still view all the mail-
boxes on the system by checking the Show All Mail-
boxes check box.)

4. Select a mailbox then click OK.
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The Transfer Greeting dialog box displays your greetings.

5. Select a greeting then click OK.

TIP: Record a special transfer greeting (one of your RNA 
greetings) and configure Manage Waiting Calls to use 
it automatically. 

Managing Greetings
Amanda provides a system Ring No Answer (RNA) greeting and a system 
busy greeting for when you do not answer or your extension is busy. 
Amanda also provides a default Name and Extension recording that 
identifies you by your mailbox. 

Unless these options have been locked by your system administrator, you 
can use Amanda Messenger to record or import .WAV files for:
• Up to seven RNA greetings. (You can switch from one greeting to 

another as appropriate.) For example, you can have one greeting for 
regular work days, another for after hours, another for when you are 
out of the office, and so forth.

• A custom busy greeting.
• A personalized Name and Extension recording.
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Controlling the RNA Greeting
You can use the system greeting or one of your own custom RNA greetings. 
You can change them to suit your needs. For example, to use different 
greetings for when you are at your desk and when you are not, change your 
greeting as you leave and return. (Routine changes, such as for daytime and 
after-hours, can be scheduled. See your Amanda system administrator for 
details.)

Amanda plays the selected RNA greeting when any of the following is true:
• Do Not Disturb is selected.
• Do Not Disturb is cleared, you do not answer the telephone, and the 

RNA Chain is blank.
• Call screening is selected and you reject the call.

If the mailbox is a message taker, Amanda plays the system greeting when 
the specified greeting does not exist.

To change the RNA greeting:

1. On the Options menu, click Greetings…

The Greetings dialog box appears.

2. Select the greeting to be used from the Greeting drop-down list box.

The Maximum Length text box defines the maximum number of sec-
onds allowed for each greeting. You cannot change this. It is under the 
control of the Amanda system administrator.

Controlling the Busy Greeting
You can use the system busy greeting or your own custom busy greeting (if 
your administrator has not locked the Custom Busy Greeting option).

To switch between the system and custom busy greetings:

1. On the Options menu, click Greetings…

The Greetings dialog box appears.
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2. Select the On check box to use your custom busy greeting. Clear it to 
use the system busy greeting.

When this check box is selected, Amanda uses your custom busy greet-
ing when your extension is busy. You can record the custom busy greet-
ing only via the telephone. For more information, see Using 
Amanda@Work.Group Telephone Features.

When cleared, the system busy greeting is used. The system busy greet-
ing allows the caller to hold for the extension by pressing *, which, in 
turn, causes Amanda to play the Busy-Hold music file (about 30 sec-
onds of custom music) before trying the extension again. If the exten-
sion is still busy, Amanda changes her prompt, allowing the caller to 
continue holding, enter another extension, or leave a message. 

The Maximum Length text box defines the maximum number of sec-
onds allowed for your custom busy greeting. You cannot change this. It 
is under the control of the Amanda system administrator.

NOTE: If the Extension text box in the General Mailbox Informa-
tion dialog box indicates an unsupervised transfer (for ex-
ample, 127H), calls cannot be placed on hold.

Playing a Greeting or Name and Extension Recording
You can listen to a greeting or your Name and Extension recording using 
either your telephone or your workstation’s sound card and speakers. (Which 
is used depends on the setting for Use Speakers. See “Setting Up Amanda 
Messenger,” earlier in this chapter, for more information.)

To play a greeting or your Name and Extension recording:

1. On the Options menu, click Greetings…

The Greetings dialog box appears.

2. Select Greeting, Name and Extension, or Custom Busy.

3. If you select Greeting, you also select the greeting to be played from the 
Greeting drop-down combo box.

(You have up to seven custom greetings and the system greeting to 
choose from.)
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4. Click Play.

Amanda Messenger plays the greeting or calls you on the telephone to 
play the greeting.

Recording a Greeting or Name and Extension Recording
You can record custom greetings or your Name and Extension recording 
using your telephone or your workstation’s sound card. (Which is used 
depends on the setting for Use Speakers. See “Setting Up Amanda 
Messenger,” earlier in this chapter, for more information.) When recording 
on your workstation’s sound card, the sound can go to the sound card from a 
microphone, CD ROM drive, or an inline jack. 

To record a greeting or your Name and Extension recording:

1. On the Options menu, click Greetings…

2. The Greetings dialog box appears.

3. Select Greeting, Name and Extension, or Custom Busy.

4. If you select Greeting, you also select the greeting to be played from the 
Greeting drop-down combo box.

(You have up to seven custom greetings to choose from.)

5. Click Record.

6. Do one of the following:

• If you have checked the Use Microphones check box in the Work-
station Options dialog box:
a. Start talking to the microphone, playing a CD, or whatever 

is appropriate. 
b. When you are done, click Stop. (The Record button chang-

es to a Stop button.)
The Approve or Reject dialog box appears.
c. Click Review to listen to your recording.
d. Click Save to save it or Cancel to reject it. If you reject the 

recording, redo steps 3 and 4.
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NOTE: For recordings made using the microphone, use the 
mixer to determine where the input is coming from. 
The mixer is usually a program that comes with the 
sound card. It is also a standard multimedia application 
within Windows 95 called “Volume.”

• If the Use Microphones check box is unchecked, Amanda will call 
your extension and prompt you through the recording session.

See “Setting Up Amanda Messenger,” earlier in this chapter, for more 
information about workstation options.

Importing a Greeting or Name and Extension Recording
You can import a .WAV file for use as a greeting. For best results, use an 8-
bit, mono .WAV file with a 11025kHz format. CD quality will also work. For 
a stereo .WAV file, you can set the Stereo Import Conversion preference. See 
“Setting Up Amanda Messenger” and “Stereo Import Conversion,” earlier in 
this chapter for more information about converting .WAV files.

To import a .WAV file as a greeting or your Name and Extension 
recording:

1. On the Options menu, click Greetings…

The Greetings dialog box appears.

2. Select Greeting, Name and Extension, or Custom Busy.

3. If you select Greeting, you also select the greeting to be played from the 
Greeting drop-down combo box.

(You have up to seven custom greetings to choose from.)

4. Click Import….

The File Open dialog box appears.

5. Use the File Open dialog box to provide the path (drive, directory, and 
filename) for the .WAV file to be imported.

6. Click OK.
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The Approve or Reject dialog box appears.

7. Click Review to listen to the .WAV file.

8. Click Save to save it or Cancel to reject it. If you reject it, you can redo 
steps 3 through 7.

9. See “Setting Up Amanda Messenger,” earlier in this chapter, for more 
information about workstation options.

Naming an RNA Greeting
To provide a name for an RNA greeting:

1. On the Options menu, click Greetings…

The Greetings dialog box appears.

2. Select a greeting to be imported from the Greeting drop-down combo 
box. 

3. Click Edit Name….

The Greeting Name dialog box appears.

4. Type a name for the greeting in the text box. 

While you can type up to 50 characters in the text box, be aware that you 
can see only about 20 of those characters in the Greetings drop-down 
combo box.

Miscellaneous
The next few sections cover general user information, managing guest 
mailboxes, and using Amanda Messenger’s menus, toolbar, and player 
controls.
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Viewing General Mailbox Information
You can view, but not change, general information about your mailbox. 

To view this read-only information:
• On the Options menu, click Mailbox Info….

The General Mailbox Information dialog box displays the following:

• The two names used for you in the employee directory. Callers can 
type the first few digits of these names and be given your extension. 
Amanda Messenger displays this information at Directory Name 1 
and Directory Name 2.

• The comment associated with your mailbox.

• The contents of your mailbox’s Extension text box. Usually this 
contains your extension. However, the administrator can use the 
Token Programming Language to program this text box.

 
General Mailbox Information  

Option Description

Directory Name 1 Amanda uses this information to build the employee directory (usu-
ally reached by dialing mailbox 411) automatically. 

Directory Name 2 Same as Directory Name 1. Amanda uses the second directory name 
to allow for an additional name, e.g., a last name or nickname. 

Comment Used by your system administrator to describe the mailbox.

Extension Controls how your incoming calls are processed. When a call ac-
cesses this mailbox and Do Not Disturb is cleared, Amanda per-
forms the programmed dial actions in this text box. Typically this 
text box contains the extension that Amanda should ring. 

Server Name The name of the Amanda Server to which you are logged on.



50 Using Amanda@Work.Group/DOS Workstation Features
Managing Guests
Your system administrator can allow you to create mailboxes for guests. For 
example, you may have a part time employee who needs to access voice mail 
for a few months.

To add a guest:

1. On the Options menu, click Guests…

The Guest List dialog box appears.

2. Click New. 

The appropriate guest mailbox number appears in the guest list. 

To delete a guest:

1. On the Options menu, click Guests…

The Guest List dialog box appears.

2. Select the guest mailbox to be deleted.

3. Click Delete. 

Using the Menus
Amanda Messenger provides a menu bar with the following menus and 
options:
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System menu

Edit menu

View menu

Log On Allows you log on to Amanda Voice Server after 
you have been disconnected for some reason. For 
example, the server may have become temporarily 
unavailable.

Stop Waiting Interrupts the action being performed. Use this 
command if communication between Amanda Mes-
senger and Amanda Voice Server slows down sig-
nificantly (due to network traffic, high levels of 
CPU activity, and so forth). 

Exit Allows you to terminate Amanda Messenger.

Undo Reverses the last editing action for the selected mes-
sages or components.

Cut Moves the currently selected messages or compo-
nents to the internal clipboard (not the Windows 
clipboard). The selected items replace the previous 
contents of the clipboard.

Copy Copies the currently selected messages or compo-
nents to the internal clipboard. The selected items 
replace the previous contents of the clipboard.

Paste Copies the messages or components currently 
stored in the internal clipboard to a message or 
Compose window.

Toolbar Displays or hides the toolbar.

Status Bar Displays or hides the status bar at the bottom of the 
window.

Player Controls Displays or hides the player controls and the slider.
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Messages menu
New Message Opens a new Compose window. 

Forward Opens a Compose window containing the compo-
nents of the selected message. On the Messages 
menu, you click Record to add a component that 
explains why you are forwarding the message, 
then click Send… to mail the contents of the Com-
pose window.

Forward Immedi-
ately…

Forwards the current message to another mailbox 
without allowing you to edit the message.

Reply Replies to the current message if it was received 
from another mailbox.

Send… Sends the current message to the specified mail-
boxes.

Import Message… Imports any .WAV file into a Compose window as 
a message component. To send the message, use 
the Send… command on the Messages menu.

Show Components Allows you to view the components of a message. 
Every message contains from 1 to 20 components.
NOTE:  You can also right-click a message to show 
its components. 

Edit Subject… Allows you to create a subject for the selected mes-
sage. Use up to 50 characters. The subject appears 
in the window in the Subject column.
NOTE:  You can also double-click a message’s sub-
ject column to edit the subject.

Save Moves the selected messages from the New Mes-
sages window or Trash Bin window to the Saved 
Messages window.
NOTE:  You can also drag the message to Saved 
Messages window.
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Play menu

Delete Moves the selected messages from the New Mes-
sages or Saved Messages window to the Trash Bin 
window.
NOTE:  You can also drag the message to Trash Bin 
window, click Delete on the toolbar, or press the 
Delete key.

Update Messages Moves messages you have heard or viewed from 
the New Messages window to the Saved Messages 
window.
NOTE: This is only available if the Auto Save 
New Messages feature is cleared.

Empty Trash Bin Permanently deletes all the messages from the 
Trash Bin window. 

Archive Message… Allows you to save a message as a .WAV file.

Fast Rewind Does one of the following:
Rewinds the voice message you are playing in ap-
proximately five-second intervals 
Goes to the previous page of the fax message you 
are viewing

Pause Causes the current voice message to pause or re-
starts it after a pause.

Stop Stops the playing or recording of the current mes-
sage.

Play Does one of the following:
• Plays the selected voice message
• Displays the selected fax message in a 

new Fax window. Each page is represent-
ed by a small thumb-nail-sized rectangle 
called a “thumbnail.” Click the thumbnail 
to magnify the page.
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Fax menu

Record Records a message using your telephone or using 
your workstation, depending on the workstation op-
tions you have set. The message appears in a Com-
pose window and can be sent to another mailbox 
using the Send… command on the Messages menu.

Fast Forward Does one of the following:
Fast forwards the voice message you are playing in 
approximately five-second intervals
Goes to the next page of the fax message you are 
viewing

View Fax Displays a fax message from Amanda Voice Server 
and displays it in Amanda Messenger.

Rotate Fax… Rotates or flips all the pages of a fax message. 

Zoom In Magnifies the display of the fax.

Zoom Out De-magnifies the display of the fax.

Import Fax Allows you to import the image file you are viewing 
as a component of a fax message.

Open… Opens an image file in TIFF, DCX, FAX and other 
image formats.

Save As… Saves the current fax message in TIFF or DCX for-
mat.

Print… Prints the current fax document.

Print Preview Displays the fax document as it would appear when 
printed.

Print Setup… Allows you to select and configure your printer.
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Options menu

Window menu

Workstation
 Options…

Allows you to set workstation options. See “Setting 
Up Amanda Messenger,” earlier in this chapter for 
more information.

Mailbox Info… Displays the current user information (name, exten-
sion, and so forth).

Security Code… Allows you to change your security code.

Basic Options… Displays the current settings for the Do Not Disturb, 
Call Screening, Identify Called Party, and Play Date 
& Time. You can change some of these options.

Greetings… Displays information about the Ring No Answer 
(RNA) and the Custom Busy greetings. You can 
change some of these options if they are not locked. 
You can also use this command to make recordings 
if your Amanda systems administrator allows you 
to record greetings and/or your name and extension 
recording.

Personal Lists… Allows you to create personal mailing lists. You can 
have up to seven personal mailing lists, each of 
which can be identified by a name. 

Guests… Allows you to create a mailbox for a guest (if your 
system administrator has configured your mailbox 
for guests).

Cascade Displays the open windows as a cascade of over-
lapping windows with the active window on top.

Tile Displays the open windows side-by-side.

Arrange Icons Aligns all minimized windows.

1 Trash Bin Selects the Trash Bin window as the active win-
dow.
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Help menu

Using Toolbar Buttons

2 Message 
Statistics

Selects the Message Statistics window as the ac-
tive window.

3 Saved Messages Selects the Saved Messages window as the active 
window.

4 New Messages Selects the New Messages window as the active 
window.

Contents Displays the contents for online help.

Using Help Explains how to use online help.

About Messenger Displays copyright information and the version 
number for Amanda Messenger.

Opens a new Compose window. This is equivalent to the New Message 
command on the Messages menu.

Opens an image file to be viewed. This is equivalent to the Open… com-
mand on the Fax menu.

Moves the selected messages from the New Messages window to the 
Saved Messages window. This is equivalent to the Update Messages 
command on the Messages menu.

Removes the selected messages or components and stores them in an in-
ternal clipboard (not the Windows clipboard). This is equivalent to the 
Cut command on the Edit menu.

Copies the selected messages or components into the internal clipboard. 
This is equivalent to the Copy command on the Edit menu.

Pastes the contents of the internal clipboard into the Compose window. 
This is equivalent to the Paste command on the Edit menu.
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Using Player Controls

Moves the selected messages from the New Messages or Saved Messages 
windows to the Trash Bin window. This is equivalent to the Delete com-
mand on the Messages menu.

Replies to the selected message. This is equivalent to the Message Reply 
command on the Messages menu.

Forwards the selected message to one or more mailboxes immediately 
(without letting you edit the message). This is equivalent to the Forward 
Immediately command on the Messages menu.

Sends the components in the active Compose window. This is equivalent 
to the Send… command on the Messages menu.

Prints the Fax message you are viewing. This is equivalent to the Print… 
command on the Fax menu.

Displays the help contents page. This is equivalent to the Contents com-
mand on the Help menu.

Enables Context Sensitive Help, allowing you to click on buttons, menus, 
or windows, to display help about them. 

Does one of the following:
• Goes to the previous page of the fax message you are viewing
• Rewinds the voice message you are playing in approximately 

five-second intervals
This is equivalent to the Fast Rewind command on the Play menu.

Causes the current voice message to pause or restarts it after a 
pause. This is equivalent to the Pause command on the Messages 
menu.
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NOTE: When messages are played to you over the telephone, you 
control the playback of a message by pressing * (back-
wards) or # (forwards). 

Stops the playing or recording of the current message. This is 
equivalent to the Stop command on the Play menu.

Does one of the following:
• Plays the selected voice message.
• Displays the selected fax messages in a new Fax window.
This is equivalent to the Play command on the Play menu.

Records a message using your telephone or your sound card, de-
pending on the workstation options you have set. The message ap-
pears in a Compose window and can be sent to another mailbox 
using the Send… command on the Messages menu. 

This is equivalent to the Record command on the Play menu.

Does one of the following:
• Goes to the next page of the fax message you are viewing
• Fast forwards the voice message you are playing in approxi-

mately five-second intervals
This is equivalent to the Fast Forward command on the Play menu.

This is used when the desktop PC is equipped with a sound card 
and a mouse. Rather than using the rewind and fast forward but-
tons, you drag the slider pointer to a certain part of the current mes-
sage while it is playing.
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Using Amanda Dialer

Getting Started
Amanda Dialer dials telephone numbers from a variety of Windows 
applications on your workstation. You select the number to be dialed. 
Amanda Dialer dials it for you and notifies you when the call is ready.

Starting and Exiting Amanda Dialer
When you start Amanda Dialer, you log on to the Amanda Voice Server.

To use Amanda Dialer:

1. Click the Amanda Dialer icon. In Windows 95, you can select Amanda 
Dialer from the Start menu. 

The Dialer Log On dialog box appears.

2. Click Network Settings…. 

The Network Settings dialog box appears. Its default settings, which are 
AMANDASERVER for the Server Name and 0 for Local Area Network 
Adapter (LANA), are correct in most cases. See your system adminis-
trator to be sure.

3. Click OK.

The Dialer Log On dialog box reappears.

4. Type your mailbox in the Mailbox text box.
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Your mailbox is probably the same as your extension number, but it 
doesn’t have to be. Check with your system administrator to be sure.

5. Type your security code in the Security Code text box.

6. Click OK.

If this is your first time using Amanda Dialer, the Amanda Dialer - 
Extension dialog box appears. It displays your mailbox.

7. If your mailbox and your extension are different numbers, type your 
extension number in Your Extension text box.

8. Click OK.

The Amanda Dialer button appears in the upper right corner of the 
screen. You can drag it to a more convenient location.

To exit Amanda Dialer:
• Right-click the dialing button, then select Exit from the context 

menu.

Setting Options
Amanda Dialer can add your outside line prefix, long distance access code, 
and international access code to the number to be dialed automatically if you 
set the Amanda Dialer options.

To set up Amanda Dialer using the Dialing Options dialog box:

1. Right-click the Amanda Dialer button.

The Amanda Dialer context menu appears.
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2. Click Dialing Options….

The Dialing Options dialog box appears.

3. If the telephone extension in Your Extension text box is incorrect, type 
the correct extension (not your mailbox—although they may be the 
same).

4. Type the number of digits (2-5 digits) in your telephone extension in the 
Extension Maximum Digits text box. 

5. By default Monitor Call Progress is cleared so that Amanda performs an 
unsupervised transfer. After the number is dialed, Amanda calls your 
extension then releases the port. (Your telephone switching system must 
be able to transfer an outside ringing line to an internal extension.)

Select Monitor Call Progress to have Amanda perform supervised trans-
fers. During a supervised transfer, Amanda monitors the call for a con-
nection status (answer, busy, or RNA). Once the status is determined, 
Amanda either calls your extension or displays a message on the screen 
explaining the connection status. If the call is answered, the called party 
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hears, “Your caller is,” followed by your Name and Extension recording.

6. Only if you selected Monitor Call Progress do you need to fill in the 
Number of Rings text box. Type the number of rings after which 
Amanda decides that the called party is not answering. The default is 4 
rings.

7. Type the number of digits in a local number in the Local Number Maxi-
mum Digits text box.

8. The default is 7 because in the United States, local telephone numbers 
are seven digits in length. 

9. Type the area code of the site from which you are calling in the Local 
Area Code text box. 

10. Type the digits necessary to get an outside line in the Outside Line Pre-
fix text box. The default is 9 followed by a comma (for a two-second 
pause).

11. Select the International Access Code check box if numbers longer than 
the usual long distance call are international. (The usual long distance 
call contains the number of digits in a local call plus the number of digits 
in an area code) If cleared, Amanda Dialer ignores International Access 
Code.

12. If you selected International Access Code, type that code in the text box. 
The default is 011, the international access code for the United States.

To restore the default settings:
• Click Defaults.
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Dialing Numbers from Windows Applica-
tions

You can use Amanda Dialer with Windows 3.11 or Windows 95. Most 
Windows programs are compatible with Amanda Dialer because they use 
Ctrl+C to copy selected text to the Windows clipboard. If you have a 
problem using Amanda Dialer from any application, copy the telephone 
number to the Windows clipboard before clicking the Amanda Dialer button.

With Windows 3.11
Once the floating dialing button is visible, you can dial a telephone number. 

To dial a number:

1. Select the telephone number to be dialed from the active window in any 
Windows application.

2. Click the Amanda Dialer button. 

The number should appear in the Amanda Dialer - Dial Number dialog 
box. 

3. If it is incorrect, edit the number. When it is correct, click Dial. 

Amanda dials the displayed number.

With Windows 95 or 98
Once the floating dialing button is visible, you can dial a telephone number. 
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To dial a number:

1. Click the Amanda Dialer button. 

2. Select the telephone number to be dialed from the active window in any 
Windows application.

3. Right-click the selected number.

The number should appear in the Number to Dial dialog box. 

4. If it is correct, select Dial. 

Amanda dials the displayed number.

NOTE: If right-clicking the selected number displays a context 
menu and the Amanda Dialer - Dial Number dialog box 
does not appear, move the mouse to another location before 
right-clicking. For example, in Schedule Plus, you can 
right-click just outside the text box that displays the select-
ed number. If the problem persists, copy the telephone 
number to the Windows clipboard before clicking the 
Amanda Dialer button.

Redialing a Number
Dialer saves the last four telephone numbers that you dialed. 

To redial a previously dialed number:

1. Right-click the Amanda Dialer button.

The Amanda Dialer context menu displays up to four recently dialed 
numbers. (In parentheses is the number of times each of these numbers 
has been dialed during this Dialer session.)
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2. Click the number to be redialed.
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Chapter 4
Using Amanda Fax

Introducing Amanda Fax
You can use Amanda Fax from any Windows application that has a Print 
command. You can send documents, spreadsheets, pictures, or anything else 
that the application can print. You can:
• Fax an item to another location via Amanda Voice Server’s fax mo-

dem
• Create a fax message to be mailed to users on your Amanda system
• Save the item as a file that can be:

• Sent later as a fax via Amanda Voice Server’s fax modem

For example, if you copy this file to Amanda Server using Amanda 
Monitor, you can fax it to callers. See the one-call and two-call fax-
back sections later in this document.

• Imported as a fax message

If you are faxing items via Amanda Voice Server or creating fax messages to 
be sent via Amanda Messenger, you need the following:
• Amanda@Work.Group 6.01 or higher in server mode
• A fax modem attached to and properly configured for use with your 

Amanda Voice Server (for more information see your system ad-
ministrator or Installing Amanda@Work.Group)

In all cases, you need the following:
• Amanda Fax installed on each workstation from which faxes will 

originate
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Sending a Fax
You can send a fax through the Amanda Voice Server’s fax modem from a 
Windows application.

To send a fax from a Windows application:

1. Select the application’s Print command.

2. Change the printer to Amanda Fax then click OK.

The Amanda Fax dialog box appears.

3. Click Fax Out….

The Amanda Fax Logon dialog box appears so Amanda Fax can verify 
that you have a mailbox and security code on the Amanda Voice Server 
to be used.

4. Click Network Settings…. 

The Network Settings dialog box appears. Its default settings, which are 
AMANDASERVER for the Server Name and 0 for Local Area Network 
Adapter (LANA), are accurate in most cases. See your system adminis-
trator to be sure.

5. Change the settings if necessary then click OK.

The Amanda Fax Logon dialog box reappears.

6. Type your mailbox in the Mailbox text box.

Your mailbox is probably the same as your extension number, but it 
doesn’t have to be. Check with your system administrator to be sure.

7. Type your security code in the Security Code text box.

(This is the same security code that you use to access Amanda over the 
telephone.)

8. Click OK.

The Fax Number dialog box appears.
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9. Indicate where to send this fax by doing one of the following:

• Type the fax number in the text portion of the Fax Number drop-
down combo box. (It may be necessary to prefix the fax number 
with an access code, such as 9 followed by a comma for an outside 
line.)

• Select a previously used fax number from the list portion of the 
drop-down combo box.

10. Click OK.

The Amanda Fax dialog reappears.

11. Click Close or send this fax again.

Saving a Fax as a File
You can save a fax as a file from a Windows application. That file can be 
copied to Amanda Voice Server (using Amanda Monitor) or imported by 
Amanda Messenger as a fax message.

To save an item as a fax file from a Windows application:

1. Select the application’s Print command.

2. Change the printer to Amanda Fax then click OK.

3. The Amanda Fax dialog box appears.

4. Click Save to File….

The File Save As dialog box appears.

5. Provide a name and location for the new file.

The default extension is .FAX, but you can use another extension. (The 
information is stored in The Amanda Company’s proprietary format, 
regardless of the extension.)
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6. Click OK.

The Amanda Fax dialog box reappears.

7. Click Close or send this fax again.

Sending a Fax Message
You can send a fax message to another user of your Amanda system from a 
Windows application. This requires you to use Amanda Messenger as well as 
Amanda Fax.

To send a fax message from a Windows application:

1. Select the application’s Print command.

2. Change the printer to Amanda Fax then click OK.

The Amanda Fax dialog box appears.

3. Click Send to Messenger….

The Messenger Identification dialog box appears.

4. Type your mailbox in the Messenger Mailbox text box then click OK.

If Amanda Messenger is running, the fax appears as a component of the 
active Compose window. If no Compose window is active, a new Com-
pose window is opened to receive this component. Go to Step 6.

5. If Amanda Messenger is not running, the Messenger Logon dialog box 
appears and you must log on to Amanda Messenger as you normally 
would:
a. Click Network Settings…. 

The Network Settings dialog box appears. Its default settings, 
which are AMANDASERVER for the Server Name and 0 for Local 
Area Network Adapter (LANA), are accurate in most cases. See 
your system administrator to be sure.



Chapter 4 Using Amanda Fax 71
b. Change the settings if necessary then click OK.

The Messenger Logon dialog box reappears.
c. Type your mailbox in the Mailbox text box. 

Your mailbox is probably the same as your extension number, but it 
doesn’t have to be. Check with your system administrator to be 
sure. 

d. Type your security code in the Security Code text box. 

(This is the same security code that you use to access Amanda over 
the telephone.) 

e. Click OK. 

Messenger starts and the fax appears as a component in a new 
Compose window.

6. To take a look at the fax before you send it, double-click the fax compo-
nent in the Compose window.

A Fax window appears which displays the pages of the fax as thumb-
nails, small rectangles about the size of a thumb nail. You can click the 
thumbnail for a better view of it and use the commands on the Fax menu 
to manipulate it.

7. When you are ready to send the fax, make the Compose window active. 
Then, on the Messages menu, click Send… to send this fax to one or 
more mailboxes and lists. 

After you send the message, you can stay in Messenger or return to the 
Amanda Fax dialog or the Windows application.

8. The Amanda Fax dialog box is still open. Click Close or send this fax 
again.

Caveats
Try some test items from any Windows application to be used for fax 
purposes before faxing items to others. For example, in Word for Windows, 
for best readability, print documents that have the page size 8 1/2 by 11 and 
portrait as the orientation.
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